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DeVELOPMENT MILESTONES
IN A CHILD

Development milestones are a set of functional /\
skills or age-specific tasks that most children can do ‘
at a certain age. These milestones help the teacher
identify and understand how children differ in
different age groups.

Cognitive

Language

Emotional/
Yeldt:1l
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First permanent tooth erupts

Shows mature throwing and catching patterns

Writing is now smaller and more readable

Drawings are now more detailed, organised and have a sense of depth

Attention continues to improve, becomes more selective and adaptable
Recall, scripted memory, and auto-biographical memory improves
Counts on and counts down, engaging in simple addition and subtraction
Thoughts are now more logical

Vocabulary reaches about 10,000 words
Vocabulary increases rapidly throughout middle childhood

Ability to predict and interpret emotional reactions of others enhances

Relies more on language to express empathy

Self-conscious emotions of pride and guilt are governed by personal responsibility
Attends to facial and situational cues in interpreting another’s feelings

Peer interaction is now more prosocial, and physical aggression declines

“ If you cannot do great things, do small things in a great way. ’ ’



Age
9 - 11 Years

* Motor skills develop resulting in enhanced reflexes

* Applies several memory strategies at once
¢ Cognitive self-regulation is now improved

e Ability to use complex grammatical constructions enhances
* Conversational strategies are now more refined

¢ Self-esteem tends to rise
* Peer groups emerge

Age
11 - 20 Years

* If a girl, reaches peak of growth spurt

* If a girl, motor performance gradually increases and then levels off
* If a boy, reaches peak and then completes growth spurt

* If a boy, motor performance increases dramatically

Cognitive * Is now more self-conscious and self-focused
* Becomes a better everyday planner and decision maker

Emotional/ * May show increased gender stereotyping of attitudes and behaviour
(Yelat:1 * May have a conventional moral orientation

Managing the children’s learning needs according to their developmental
milestones is the key to a successful teaching-learning transaction in the
classroom.

Family is the most important thing in the world.



TEACHING PEDACOGIES

Pedagogy is often described as the approach
to teaching. It is the study of teaching methods
including the aims of education and the ways in
which such goals can be achieved.

A lesson plan is the instructor’s road map which specifies what students need to learn and
how it can be done effectively during the class time. A lesson plan helps teachers in the
classroom by providing a detailed outline to follow in each class.

A lesson plan addresses and integrates three key components:
Learning objectives
Learning activities
Assessment to check the student’s understanding

A lesson plan provides an outline of the teaching goals:

1. Identify the learning objectives.

2. Plan the lesson in an engaging and meaningful manner.
3. Plan to assess student’s understanding.

4. Plan for a lesson closure.

Present the lesson plan.

Reflect on what worked well and why. If needed, revise
the lesson plan.

Knhowing yourself is the beginning of all wisdom.



Numerous strategies have evolved over the years to facilitate the teaching-learning process
in the classrooms.

Effective Teaching
Strategies

Direct Performance Classroom CS,mall Student Problem Cooperative
Instruction Activities Discussion \)(:ZL:E Research Solving Learning

Bloom’s Taxonomy

Bloom’s Taxonomy was created by Dr Benjamin Bloom and several of his colleagues, to
promote higher forms of thinking in education instead of rote learning. There are three
domains of learning: cognitive (mental), affective (emotional), and psychomotor (physical).
However, when we refer to Bloom’s Taxonomy we speak of the cognitive domain. Bloom’s
Taxonomy is a list of cognitive skills that is used by teachers to determine the level of
thinking their students have achieved. As a teacher, one should attempt to move students
up the taxonomy as they progress in their knowledge.

Produce
Use Take apart something
information information Justify a new
in new to show stand or T
situations, relationships, position :
to answer causes and T LEVEL 6
questions connections H
or solve LEVEL 5 Creating
problems H
Explain ideas H LEVEL 4 Evaluating
Recall fagts or conceptg :
and basic T LEVEL 3
concepts !
T

H LEVEL 2 plying
LEVEL1 standing

Teachers should focus on helping students to remember information before expecting
them to understand it, helping them understand it before expecting them to apply it to a
new situation, and so on.

“ If you have no confidence in self,
you are twice defeated in the race of life. ’ ,
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Part-A: Employabhility Skills

Teaching Objectives

By the end of this unit, students will be able to:

Define communication and describe the communication process.
Understand and apply the 7Cs of effective communication.

Recognise various communication styles and methods.

Improve public speaking and refusal skills.

Understand basic grammar, sentence construction, and paragraph writing.

Ask questions and describe daily routines using correct sentence structures.

+ + + + + 4+ +

Apply assertive communication and non-verbal cues effectively.

Teaching Plan

. Theory Practical
1. Introduction (Engagement)

Activities:

e Start with discussion questions:
o What is communication?
o Why is communication important in our personal and professional life?
o How do we communicate without words?

e Brainstorm examples of verbal, non-verbal, and visual communication.

2. Lesson Delivery (Explanation & Demonstration)

A. Understanding Communication

e Define communication and explain the communication process.

e Identify components: Sender, Message, Encoding, Channel, Receiver, Decoding,
Feedback.

e Activity: Roleplay demonstrating each component using real-life examples.
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B. Communication Methods
e Verbal Communication: Oral and Written.
e Non-verbal Communication: Gestures, Posture, Facial Expressions.
e Visual Communication: Images, Signs, Charts.
e Group Task: Students categorise communication types from daily life scenarios.
C. Barriers & Perspectives
e Discuss language, emotions, prejudice, environmental and cultural factors.
e Activity: Discuss case study of communication failure and how it could be avoided.
D. The 7Cs of Effective Communication
e C(Clear, Concise, Concrete, Correct, Coherent, Courteous, Complete.
e Task: Rewrite vague sentences using the 7Cs.
E. Communication Styles
e Passive, Aggressive, Passive-Aggressive, Assertive.
e Activity: Students act out scenes with different communication styles.
e Discussion: Why assertive style is most effective?
F. Public Speaking — 3Ps Model
e Prepare, Practise, Perform.
e Activity: Deliver 1-minute talks with feedback on clarity and confidence.
G. Saying ‘No’ - AEIOU Model
e Teach assertive refusal using Ask, Express, Inform, Offer, Understand.
e Roleplay: Saying No in challenging social situations.
H. Basics of Grammar & Writing
e Parts of Speech: Noun, Pronoun, Verb, Adjective, Adverb, etc.
e Sentence Construction: Subject, Verb, Object.
e Types of Sentences: Declarative, Interrogative, Imperative, Exclamatory.
e Paragraph Writing Structure: Topic Sentence, Supporting Details, Conclusion.
e Practice: Create short paragraphs and identify sentence types.
I. Asking Questions
e Open-ended vs Closed questions.
e Activity: Convert statements into questions, identify types.
J. Daily Routines, Greetings, Family Introduction
e Activity: Write your daily routine using frequency adverbs.

e Introduce yourself and your family using possessive adjectives.
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Extension

Ask the students some oral questions based on this chapter.

What are the main elements in the communication process?

Can you name and explain any three barriers to effective communication?
What are the 7Cs of communication and why are they important?

How do verbal and non-verbal communication differ?

What does the AEIOU model help us with?

oo 0000

Can you describe a situation where you used assertive communication?

Evaluation
e  Create a visual family tree and present to class.
e  Play "Feelings Charades” to recognise non-verbal cues.

e  Record a 1-minute speech using 3Ps technique and get peer feedback.

Summative Assessment
e Quiz on communication process, methods, barriers, and 7Cs.

e  Written paragraph describing a day in your life using correct sentence structure.

Practical Assessment
e  Deliver short speech (graded on clarity, confidence, and structure).

e  Fill a mock form and introduce yourself.

Suggested Activity
e  Debate: “Verbal vs Non-Verbal Communication — Which is More Powerful?”
e  Group Presentation: Visual communication examples and their cultural significance.

e  Creative Poster: 7Cs of Communication with examples.

Teaching Objectives

By the end of this unit, students will be able to:

+ Understand the importance of knowing oneself (values, beliefs, strengths, and weaknesses).
+ Explore identity, personal background, and self-reflection practices.

+ Practise effective grooming and personal hygiene habits.
+

Develop time management and goal-setting techniques using the SMART framework.
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+

Identify and apply self-motivation strategies.

+ Understand and demonstrate effective teamwork and networking skills.

Teaching Plan

Introduction (Engagement) Theory  Practical

1.

«<

Activities:

Begin with the question: "What are you good at, and what do you enjoy doing?”
Discussion: "Why do people behave differently in the same situation?”

Ice-breaker activity: “Strength and Weakness Wall” — Students anonymously post one
strength and one weakness on the classroom wall.

Lesson Delivery (Explanation & Demonstration)

A.

Knowing Yourself & Identity

o Define belief, values, likes/dislikes, opinions, and background.

e Explain the concept of identity and how self-awareness helps in decision making.

e Activity: Reflection worksheet — “Who am I?”

Strengths vs Weaknesses & Interests vs Abilities

e Discuss how to identify strengths and weaknesses using feedback and self-analysis.
e Clarify difference between interests and abilities.

e Group Task: Students list hobbies and rate themselves on ability vs interest.

. Impressive Appearance & Grooming

e Explain the role of first impressions, body language, and personal grooming.
e Demonstrate: Grooming checklist (hair, dress, shoes, nails, etc.)

e Activity: "Dress for Occasion” roleplay: Which dress for which scenario?

. Personal Hygiene & Handwashing Techniques

e Discuss importance of hygiene in health and social life.

e Demonstrate correct handwashing steps.

e Activity: Hygiene habit tracker for 1 week.

Self-Exploration Approaches

e Formal Learning, Informal Learning, Career Counsellors, Self-Reflection, and Feedback.
e Activity: Create a mini-portfolio with reflections and skills learned from different sources.
Teamwork

e Define teamwork, team members, and benefits.

e Show video: “The Power of Teamwork”

e Activity: Tower Challenge — build tallest structure using limited materials in groups.
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G. Networking Skills & CONECT Model
e Explain networking, benefits and six steps of CONECT.
¢ Roleplay: Meet-and-greet scenario to practise CONECT steps.
H. Self-Motivation
e Define motivation and explain intrinsic vs extrinsic motivation with examples.
e Video Session: "How to stay self-motivated”
e Task: Create personal motivation collage or quote wall.
I. Goal Setting & SMART Goals
e Explain SMART goals with examples.
e Activity: Students create one SMART goal for academic and one for personal life.
J. Time Management
e Importance of time and how to plan efficiently.
e Introduce daily planner, to-do list, and prioritisation.

e Activity: “Time Log" — Track daily time usage and reflect on improvement areas.

Extension

Ask the students some oral questions based on this chapter.
What do you think makes you unique as a person?

Can you describe the difference between interest and ability?
Why is it important to maintain personal hygiene?

How can SMART goals help in achieving success?

What does self-motivation mean to you, and how do you practise it?

oo o000

Can you name any situation where teamwork helped you accomplish a task?

Evaluation
e  Poster creation on Time Management Tips or Self-Motivation Quotes.
e  Group presentation: Role of grooming and hygiene in personality development.

e  Debate: "Hard Work vs Smart Work” or “Discipline vs Motivation.”

Summative Assessment
e Quiz: Types of motivation, CONECT model, hygiene steps.

e Short answers: Difference between interests & abilities, define identity, time management
tips.
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Practical Assessment
e  Presentation of personal goal plan and time log.
e  Grooming demo and hygiene checklist submission.

e  Team activity performance (graded on cooperation and participation).

Suggested Activity
e  Create a "My Weekly Planner” chart and submit.
e  Group Poster: "SMART Goals for Students”

e  Self-reflection essay: "Three things I learnt about myself in this chapter.”

Teaching Objectives

By the end of this unit, students will be able to:

Understand the purpose and advantages of using a word processor.

Identify and use major components of the LibreOffice Writer interface.

Format text using font styles, sizes, alignments, and text effects.

Insert and manage lists, tables, pictures, shapes, headers, footers, and page numbers.

Apply spell checking and grammar tools.

Track and manage changes in a document. Number of Periods

Theory Practical

+ 4+ 4+ o+ o+

Teaching Plan
1. Introduction (Engagement)
Activities:
e Ask students: “"Have you used a word processor before? For what purpose?”
e Display before/after samples of formatted and unformatted documents.
e Brainstorm how digital documents improve productivity.
2. Lesson Delivery (Explanation & Demonstration)
A. Introduction to Word Processing
e Define ICT and word processor.
o Discuss benefits: editing, formatting, saving, printing, visual enhancement.
e Activity: Create a basic document with a title and a paragraph.
B. Exploring LibreOffice Writer Interface
e Demonstrate Menu Bar, Toolbars, Zoom, and Status Bar.

e Activity: Identify elements in the Writer interface through worksheet.
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C. Creating and Managing Documents

e New, Save, Open, Close, Print, Print Preview.

e Shortcuts: Ctrl+N, Ctrl+S, Ctrl+P.

e Activity: Practice saving a document and using Print Preview.
D. Formatting Text

e Font style, size, bold, italics, underline, text alignment.

e Shortcuts: Ctrl+B, Ctrl+I, Ctrl+U.

e Activity: Format a given paragraph with specific text properties.
E. Editing Tools

e Cut, Copy, Paste, Find & Replace (Ctrl+X, Ctrl+C, Ctrl+V, Ctrl+H).

e Activity: Use Find & Replace to correct repeated spelling errors.
F. Spell Check & Grammar

e Use F7 or Shift+F7 to check document correctness.

e Demonstrate Auto Spell Check feature.

e Activity: Introduce errors and correct using spell checker.
G. Inserting Lists, Tables, Pictures, and Shapes

e Bulleted/Numbered lists: Format > Bullets and Numbering.

e Insert Table: Table > Insert Table / Ctrl+F12.

e Insert Image: Insert > Image.

¢ Insert Shapes: Drawing Toolbar > Shape.

e Activity: Create a formatted profile using a list, a table, and an image.
H. Adding Headers, Footers & Page Numbers

e Header/Footer: Insert > Header/Footer > Default Page Style.

e Add Date, Title, Page Number.

e Activity: Create a document with header/footer containing title and page numbers.
I. Tracking Changes in a Document

e Use: Edit > Track Changes > Record.

e Approve/Deny changes, Accept All/Deny All.

e Protect changes with password.

e Activity: Simulate a peer review using Track Changes.
J. Compare Documents

e Compare two versions of a document.

e Activity: Modify a peer's document and compare with original.
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Extension

Ask the students some oral questions based on this chapter.

What is the purpose of using a word processor?

How do you use the ‘Track Changes’ feature in LibreOffice Writer?
Which shortcut do you use to print a document?

What are the steps to insert a table or image in a document?

Why is formatting important in a document?

oo 0000

Can you list three editing tools and their functions?

Evaluation
e  Poster creation: “Advantages of Digital Documentation.”
e Debate: "LibreOffice Writer vs Google Docs.”

e  Write an article, format, insert image, and save it.

Summative Assessment
e Quiz: Toolbars, shortcuts, menus, and functions.

e  Written: Define word processor, tracking changes, spell checking tools.

Practical Assessment

e  Students complete tasks: type, format, insert image and table, add header/footer, run spell
check, and track changes.

e  Peer document comparison and feedback session.

Suggested Activity

e Type and format an assigned paragraph.

e Create a birthday party invitation using Writer.

e  Group Task: Create a school newsletter using various Writer features.

e Create a table-based student report card with styles and alignment.

Teaching Objectives
By the end of this unit, students will be able to:
+ Define entrepreneurship and differentiate it from traditional business.

+ Identify and explain types of business activities: manufacturing, trading, and services.
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Recognise values and attitudes essential for successful entrepreneurs.
Demonstrate problem-solving techniques using creativity, innovation, and critical thinking.
Generate and evaluate business ideas.

Understand customer and market needs through surveys and competitor analysis.

+ 4+ 4+ o+ o+

Explain the importance of a business plan and methods to improve business growth.

Teaching Plan

1. Introduction (Engagement) Theory  Practical
Activities:
e Ask students: "What comes to your mind when you hear the word ‘entrepreneur’?”
e Display stories of famous entrepreneurs and initiate a classroom discussion.
e Brainstorm: Why do some businesses succeed while others fail?
2. Lesson Delivery (Explanation & Demonstration)
A. Introduction to Entrepreneurship
e Define entrepreneurship with examples.
e Compare entrepreneur vs businessperson.
e Activity: Watch video "What is an Entrepreneur?” and answer guided questions.
B. Types of Business Activities
e Manufacturing, Trading, Services — with real-world examples.
e Case Study: Identify type of business from given scenarios.
C. Entrepreneurial Values
e Confidence, Independence, Perseverance, Open-mindedness.
e Activity: Value Identification from stories (e.g., Santosh and Asha).
e Group Task: Poster on “"Values of a Successful Entrepreneur”.
D. Attitude of an Entrepreneur
e Belief in Self, Focus on Customer, Decision Making, Responsibility.
e Compare Entrepreneur vs Employee — Discuss attitudes.
¢ Roleplay: Entrepreneurial vs Employee responses to same scenario.
E. Problem-Solving in Entrepreneurship
e Define and explain problem-solving, creativity, innovation, and critical thinking.
e Task: Analyse a business problem and propose three solutions.
F. Generating a Business Idea

e Define a business idea and sources of idea generation.
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e Types: Location-based, Season-based, Event-based, Interest-based, Study-based.
e Activity: Think-Pair-Share — Generate a business idea and present.
G. Principles of Idea Creation
e Based on: Customer Need, Entrepreneur’s Interest, Innovation.
e Case Activity: Match principle with example.
H. Understanding the Market
e Customer Needs: Fulfilled, Partially Fulfilled, Unfulfilled, Unknown.
e Activity: Identify need type from sample scenarios.
I. Customer and Competitive Surveys
e Conducting customer and competitor surveys.
e Activity: Design a short customer survey and conduct a mock interview.
J. Business Planning & Growth
e Elements and importance of a business plan.
e Methods of Growth: Quality, Scale-up, Offers.
e Activity: Create a mini business plan with goals, team, and offerings.
Extension
Ask the students some oral questions based on this chapter.
What is the difference between an entrepreneur and a businessperson?
Can you name three values that every entrepreneur should have?
What are the three main types of business activities?
How can creativity help in solving a business problem?

What is a business plan and why is it important?

oo 0000

How can customer feedback help in improving a business idea?

Evaluation
e Interview a local entrepreneur and present their values and growth strategies.
e  Group Discussion: “Are entrepreneurs born or made?”

e Create an elevator pitch for a new business idea.

Summative Assessment
e  Quiz on entrepreneurship concepts, value traits, business planning.

e Short answers: Define entrepreneurship, value examples, problem-solving traits.
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Practical Assessment
e  Group business plan presentation.
e  Survey development and roleplay feedback.

e Poster presentation of entrepreneur values.

Suggested Activity
e  Prepare and present a business model canvas.
e  Group competition: Build the most creative business idea from given materials.

e  Write a reflection: "If I were an entrepreneur, I would...”

Teaching Objectives

By the end of this unit, students will be able to:

+ Understand the concept and principles of the Green Economy.

+ Identify various sectors contributing to the Green Economy.

+ Recognise key policies and government initiatives that support green development.
+ Understand the role of different stakeholders in achieving sustainability.
+

Explore examples of Green Projects in India and apply these ideas to local contexts.

Teaching Plan

1. Introduction (Engagement) Theory  Practical
Activities:
e Ask: "What comes to mind when you hear ‘Green Economy'?”
e Watch introductory videos on Green Economy and Green Growth.
e Brainstorm real-world issues: pollution, climate change, resource depletion.
2. Lesson Delivery (Explanation & Demonstration)
A. What is Green Economy?
e Define Green Economy: low-carbon, resource-efficient, socially inclusive.
e Discuss economic and environmental aspects.

e Activity: Draw Green Economy triangle (Low Carbon + Resource Efficiency + Social
Inclusivity).

B. Sectors of Green Economy

e Agriculture: Promote organic/local farming.
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e Transport: Encourage electric vehicles, public transport.

e Water Management: Conservation and wastewater treatment.

e Waste Management: Reduce, reuse, recycle.

e Forestry: Prevent deforestation, promote sustainable forestry.

e Activity: Create posters for each sector with green solutions.
C. Green Economy Policies

e National Action Plan on Climate Change (NAPCC) and its 8 missions.

e Green India Mission, National Solar Mission, Swachh Bharat Abhiyan.

e Role of National Green Tribunal (NGT).

e Activity: Quiz on national missions and their objectives.
D. Stakeholders in Green Economy

e Government: Policies, enforcement, education.

e Private Sector: Business practices and compliance.

e NGOs, Farmers, Workers, Native Tribes, Scientists.

e Activity: Roleplay — simulate a Green Economy Town Hall with various stakeholders.
E. Government & Private Agency Functions

e Functions of Ministries: MoEFCC, Energy, Rural Development.

¢ Role of Private Agencies: Support, awareness, innovation.

e Activity: Debate — Government vs Private sector: Who should lead Green Initiatives?
F. Examples of Green Projects in India

e Mitticool clay refrigerator, Walkie-Talkie Charger, Windmill Tube Well.

e Liter of Light project, Banana Fibre Products.

e Activity: Group project — identify a local problem and propose a green solution.

Extension

Ask the students some oral questions based on this chapter.

oo o000
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What is a Green Economy? Can you name its three key characteristics?
Why is reducing carbon emissions important for sustainability?

Can you name three sectors that contribute to the green economy?
What is the function of the National Green Tribunal (NGT)?

Give an example of a green project in India and describe its impact.

How can individuals contribute to a greener environment in their daily life?
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Evaluation
e  Research and present on Vandana Shiva and Ecofeminism.
e Design a green eco-cityscape poster.

e Investigate the Chipko Movement and similar environmental actions

Summative Assessment
e Quiz on definitions, national missions, roles of NGT and stakeholders.

e  Written: Explain Green Economy, key projects, policies, and sectors.

Practical Assessment
e Create and present a group green solution plan.

e  Mock interview/reporting of an environmental violation to the NGT.

Suggested Activity
e  Poster on "Ways to Conserve Water” or “"Say No to Plastic”.
e Create a local waste-to-product prototype.

e  Group discussion: "Is the Green Economy the Future of India?”
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Teaching Objectives

By the end of this unit, students will be able to:

Define Artificial Intelligence and differentiate it from traditional technologies.
Understand the history, importance, and real-life applications of Al

Identify types of AL: ANI, AGI, ASL

Understand core domains of Al: Data Science, NLP, and Computer Vision.

Explore Al terminologies, cognitive computing, ML, and DL.

+ 4+ + + o+ o+

Apply knowledge of machine learning types through practical examples.

Teaching Plan

1. Introduction (Engagement) Theory Practical
Activities:
e Ask: "Do you use Siri, Alexa, or Google Assistant? How do they work?”
e Brainstorm daily examples of Al students have seen or used.
e Video: "Al in 5 Minutes” followed by classroom discussion.
2. Lesson Delivery (Explanation & Demonstration)
A. What is Artificial Intelligence?
e Define Al — human-made thinking ability.
¢ Highlight mental abilities simulated: problem-solving, learning, planning.
e Difference between Al and traditional rule-based systems.
B. History of Al
e Timeline: 1943 (Neurons) to 2011 (Watson beats humans in Jeopardy).

e Key milestones: Turing Test, Logic Theorist, Deep Blue, Al Winter.
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e Activity: Match-the-year timeline puzzle.

. Why AI Matters?

e Real-world uses: Healthcare, education, transport, finance.
e Survey chart showing importance of Al across sectors.

e Activity: Think-Pair-Share — How Al benefits society.

. Types of Al

e ANI (Narrow), AGI (General), ASI (Super Intelligence).

e Examples: Siri, Ultron, Ex Machina.

e Activity: Categorise given technologies under ANI, AGI, or ASL

. Domains of Al

e Data Science: Analyses numeric/alphanumeric data.

e NLP: Interacts using human language (e.g., chatbots).

e Computer Vision: Understands visual data (e.g., facial recognition).

e Activity: Match real-world applications to Al domains.

. Data and Data Science

e Types of Data: Structured, Semi-structured, Unstructured.
e Advantages and Applications of Data Science.
e Activity: Categorise data from online platforms into data types.
. Natural Language Processing
e NLU vs NLG — Meaning extraction vs language generation.
e Real-life use: Grammarly, Google Translate, Alexa.
e Activity: Fill the blanks with NLP tool functionalities.
. Computer Vision
e Pixels and images, how computers interpret visuals.
e Use in security, AR filters, medical imaging.
e Activity: Explore AutoDraw or Thing Translator.
Cognitive Computing
e Decision support systems: simulate reasoning and behaviour.
e Examples: IBM Watson, Microsoft Cognitive Services.
e Comparison: Al vs Cognitive Computing.
e Activity: Case study analysis — Cognitive assistant job matching.
. Al Terminologies & ML Basics

e Machine Learning, Deep Learning.
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e Neural Networks, Supervised, Unsupervised, Reinforcement Learning.
e Activity: Group comparison chart — Al vs ML vs DL.
K. Deep Learning and Neural Networks
e Input, hidden, output layers.
e Backpropagation and activation.
e Applications: cancer detection, aerospace, automation.
L. Types of Machine Learning
e Supervised: labelled data, classification (email spam).
¢ Unsupervised: unlabelled data, clustering (customer segmentation).
¢ Reinforcement: agent learning from feedback (games, finance).

e Activity: Identify ML types from real-life case scenarios.

Extension

Ask the students some oral questions based on this chapter.

What is Artificial Intelligence, and how is it different from traditional programming?
Can you name three real-life examples where Al is being used?

What are the three types of Al and how do they differ?

How is NLP used in daily applications like mobile phones or web apps?

What is the difference between Supervised and Unsupervised Learning?

oo 0000

Why is it important for Al to learn from data?

Evaluation
e Use Google Teachable Machine to train image model.
e Read Al-in-Cinema articles: analyse portrayal vs reality.

e  Game-based reinforcement learning (Tower of Hanoi / Tic Tac Toe with Al).

Summative Assessment
e Short answers on supervised learning, history of Al, benefits of AL

e Long answers: Difference between ML & DL, applications of AL

Practical Assessment
° Practical Al tools: AutoDraw, Teachable Machine, LearnML Games.
e  Students build supervised learning image model.

e  Categorisation of apps by Al domain.
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Suggested Activity
e  Poster: "Al in Daily Life” or “Difference Between Al ML and DL".
e  Debate: "Will Al Replace Human Jobs?”

e  Project: Create an Al-based presentation using examples from media, healthcare, education,
and daily life.

Teaching Objectives

By the end of this unit, students will be able to:

+ Understand the increasing global demand for careers in AL
Identify common job roles and required skills in the Al sector.

+
+ Explore Al's role across various industries such as healthcare, finance, agriculture, and retail.
+ Recognise key technical, soft, and foundational skills necessary for a career in AL

+

Discover experiential and interdisciplinary applications of Al for personal and career development.

Teaching Plan

1. Introduction (Engagement) Theory  Practical
Activities:
e Ask: "Can Al help you choose a career or write your resume?”
e Share a short video on Al in career planning.
e Group discussion: “What Al-based tools or assistants have you interacted with recently?”
2. Lesson Delivery (Explanation & Demonstration)
A. Global Demand for Al Careers
e Discuss how Al is shaping industries and increasing job roles.
e Refer to WEF Jobs Report 2023 highlighting top roles in AL
e Activity: Survey which sectors students are most interested in working with AL
B. Common Job Roles in Al

e Al Engineer, Data Scientist, Al Ethicist, Robotics Engineer, NLP Engineer, ML Engineer,
etc.

e Explain responsibilities and tools used (e.g., Python, TensorFlow).
e Matching Activity: Connect job roles with their key responsibilities.
C. Industry-Wise Applications of Al
e Sectors: Agriculture, Healthcare, Retail, Finance, Media, Tourism, Military, etc.

e Activity: Group presentation on “How Al is transforming [chosen industry]”.
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D. Essential Skills for Al Careers

e Technical Skills: Programming, ML/DL, Neural Networks, Shell Scripting, Big Data,
Sensor Fusion.

e Soft Skills: Problem-solving, communication, time management, teamwork.
e Baseline Skills: Statistics, Linear Algebra, Signal Processing, Probability.
e Quiz: Match skills to real-world Al applications.
E. Traits of an Al Professional
e Curiosity, creativity, adaptability, and communication.
e Discussion: "Why soft skills matter just as much as coding in Al careers.”
F. Tools & Frameworks for Al
e Python, R, Java, C++, TensorFlow, SciPy, NumPy, Tableau.
e Demonstration: Al resume writer (Wordtune) or Logo Maker (logoai.com).
G. Experiential Learning
e Generate music using Al (Soundraw.io).
e Watch: "10 Ways Al is Transforming Industries Right Now."
e Activity: Write responses based on the video — name 5 Al transformations.
H. Career Opportunities Table Analysis
e Review job roles and subjects needed across 15+ industries.
e Task: Students choose an industry and map their current skills to future career
possibilities.
Extension
Ask the students some oral questions based on this chapter.
What are the most in-demand careers in the field of Artificial Intelligence?
Name three job roles in Al and describe their responsibilities.
How can Al be used in industries like healthcare and finance?
What technical and soft skills do you need for an Al career?

How can Al tools help in resume building and career guidance?

o ooooLo

Why is experiential learning important when preparing for Al-based careers?

Evaluation
e  Create Al-powered business or app idea.
e  Use Al to create a resume and logo.

e Research top universities and free learning platforms for Al (Kaggle, IBM SkillsBuild, W3Schools).
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Summative Assessment
e  Objective and subjective questions (based on textbook exercise).

e  Competency-based questions related to real job role scenarios (e.g., NLP Engineer, Al Consultant).

Practical Assessment
e  Generate Al output using tools (resume, logo, or music).
e  Presentations: "Al Career I Aspire Towards and Why."

e Analysis of skills needed for a chosen Al job.

Suggested Activity
e Create a career roadmap poster for an Al job role.
e  Group debate: "Will Al create more jobs than it replaces?”

e Activity: Al Tools Scavenger Hunt — explore online tools that support Al learning and creativity.

Teaching Objectives

By the end of this unit, students will be able to:

Understand the basics of Python, including its features and syntax.
Perform input/output operations and use Python comments.
Differentiate between various Python modes: interactive and script.
Work with character sets, tokens, variables, and data types.
Implement control structures: sequence, selection, and iteration.
Use different operators: arithmetic, relational, logical, bitwise, etc.
Perform operations on data structures: lists, tuples, dictionaries.

Read from and write to CSV files.

o+

Understand and use libraries such as NumPy and Pandas.

Teaching Plan

1. Introduction (Engagement) Theory Practical
Activities:
e Ask: "Have you seen Python code before? What was it used for?”
e Display simple Python script and show how easy it is to read.

e Discuss the popularity and applications of Python in Al, web development, and automation.
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Lesson Delivery (Explanation & Demonstration)
A. Getting Started with Python
e Python history and features (interpreted, dynamic, open-source, portable).
e Installing Python from official site.
e Overview of editors: IDLE, PyCharm, Jupyter Notebook.
e Activity: Install Python and run your first print statement.
B. Python Modes and Input/Output
e Interactive vs Script Mode.
e Using input() and print() with examples.
e Format method and string interpolation.
e Activity: Write a script to input name and marks, and print them using format().
C. Python Syntax & Comments
e Indentation importance.
e Single-line and multi-line comments.
e Activity: Add comments to a given program to explain each line.
D. Tokens in Python
e Keywords, Identifiers, Literals, Operators, and Punctuators.
e Variable naming rules.
e Activity: Identify tokens in a given code snippet.
E. Python Operators
e Arithmetic, Comparison, Assignment, Logical, Bitwise, Membership, Identity.
e Operator precedence.
e Activity: Write a program using all operator types.
F. Control Structures
e Sequence, Selection (if, if-else, elif), and Loops (for, while).
e Jump statements: break, continue.
e Activity: Write a guessing game using loops and conditionals.
G. Data Types and Type Casting
e Numeric, Boolean, Sequence, Set, Dictionary, None.
e Implicit and explicit casting.

e Activity: Use type() to display types; convert between int, str, and float.
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H. Working with Lists, Tuples, and Dictionaries

e Create, access, update, and delete elements.

e List methods: append(), insert(), extend(), pop(), remove().

e Tuple immutability and Dictionary key-value management.

e Activity: Create a student record using all three structures.
I. File Handling with CSV Files

e Reading from, writing to, and appending data in CSV.

e Use of csv module.

e Activity: Build a mini customer database using CSV files.
J. Understanding Libraries: NumPy, Pandas, Scikit-learn

e NumPy arrays: 1D, 2D, nD.

e Basics of Pandas and dataframes.

e Activity: Create NumPy arrays and perform basic operations.

Extension

Ask the students some oral questions based on this chapter.

Q. What are the key features that make Python a preferred language for beginners?
Q. What is the difference between interactive and script mode in Python?

Q. Can you explain how indentation affects Python code execution?

Q. How do lists and tuples differ in Python?

Q. What is the purpose of the csv module in Python?

Q. Why are libraries like NumPy and Pandas important in data science?

Evaluation

e  Explore Google Colab for Jupyter Notebooks.
e Visit Python official docs and W3Schools tutorials.

e  Research careers in Python development, data science, and AL

Summative Assessment
e  Objective and descriptive questions on Python basics and syntax.

e Long answers on list/tuple/dictionary operations and control statements.

Practical Assessment
e  Projects using control structures and data types.
e  CSV file creation and data entry.

e NumPy operations and output interpretation.
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Suggested Activity

Write a program to display multiplication table of a given number.
Develop a calculator using if-elif-else.
Create a resume dictionary with nested key-value pairs.

Code a program to analyse and count vowels in a given sentence.

Teaching Objectives

By the end of this unit, students will be able to:

+ o+ o+ o+ o+

Teaching Plan

1.

«<

Understand the stages of the Design Thinking process.

Apply Right Questioning using 5W and 1H method.

Develop Empathy Maps for user-centred problem-solving.

Identify real-world problems to solve through Al-based Capstone Projects.
Understand and align projects with Sustainable Development Goals (SDGs).
Decompose problems into manageable parts.

Follow the Al Project Cycle from problem scoping to deployment.

Number of Periods

Theory Practical
Introduction (Engagement)

Activities:
e Ask students: “"Have you ever thought of solving a real-world issue using AI?"

e Group Discussion: "Recall the story of the Thirsty Crow. What design thinking principles
did the crow use?”

e Watch: Design Thinking Animation Video followed by a Q&A session.
Lesson Delivery (Explanation & Demonstration)
A. Design Thinking

e Stages: Empathise, Define, Ideate, Prototype, Test.

e Activity: Create a Design Thinking Mind Map using classroom examples.
B. Empathise & Empathy Mapping

e Definition and importance of empathy.

e 4 Quadrants: Says, Thinks, Does, Feels.

e Activity: Create an Empathy Map for a hospital patient or a student using online
template.
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. Right Questioning with 5W and 1H

e WHO, WHAT, WHERE, WHEN, WHY, HOW.

e Activity: Construct a SW1H Canvas for a problem like “climate change due to CO,
emissions”.

. Sustainable Development Goals (SDGs)

e Understand all 17 SDGs.
e Interrelation between goals.

e Activity: Choose one SDG and brainstorm a project idea around it.

. Identifying a Problem to Solve

¢ Importance of problem identification.

e Activity: "What is the root cause?” — Mini case study discussion.

. Ideation Techniques

e Brainstorm, Brain dump, Brainwriting.

e Activity: Group ideation for the problem identified using all three techniques.

. Problem Decomposition

e Steps: Understand — Break — Divide — Code/Build.

e Activity: Decompose a problem like building a school website.

. Capstone Project Understanding

e What is a Capstone Project?

e Features: Passion-driven, Practical, Feasible, Career-oriented.

e Activity: Explore sample projects (e.g., chatbot, health prediction, emotion analysis).

Al Project Cycle

e 6 Steps: Problem Scoping, Data Collection, Data Exploration, Al Modelling, Evaluation,
Deployment.

e Activity: Break students into groups and simulate an Al project using a one-act play
(e.g., security system model).

Extension

Ask the students some oral questions based on this chapter.

oo o000

What are the five stages of the Design Thinking process?

How can empathy maps help us solve real-world problems?

Can you explain the 5W and 1H questioning technique with an example?
How do Sustainable Development Goals (SDGs) relate to Al projects?
What are the key stages of the Al Project Cycle?

Why is it important to decompose a problem before solving it?
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Evaluation
e  Use online tools to build an empathy map.
e Apply 5W1H Canvas to social issues in the local community.

e  Research existing capstone projects and present findings.

Summative Assessment
e  Objective and descriptive questions from the textbook.

e Long answers on project cycle stages, SDG integration, and problem decomposition.

Practical Assessment
e  Design of empathy map and 5W1H canvas.
e  Capstone project theme proposal based on SDG.

e  Prototype simulation or dry run.

Suggested Activity

e  Create a Capstone Project plan (theme, scope, SDG goal).

e  Prepare a sample project logbook: meeting minutes, user interviews, problem definition.
e  Discuss and evaluate sample capstone projects.

e  Debate: "Why identifying the problem is more important than solving it.”

Teaching Objectives

By the end of this unit, students will be able to:

Define and understand data and its types (structured, semi-structured, unstructured).
Differentiate between primary and secondary data sources.

Apply statistical tools (mean, median, mode, variance, and standard deviation).
Create various data visualisations using Python (matplotlib).

Understand and operate with matrices and apply them in AL

+ 4+ + + o+ o+

Perform data preprocessing and understand training/testing datasets.

Teaching Plan

1. Introduction (Engagement) Theory Practical
Activities:
e Ask: "Why is data called the fuel of AI?"
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e Brainstorm everyday data sources: phone usage, sensors, online shopping.
e Ice-breaker quiz on types and sources of data.
Lesson Delivery (Explanation & Demonstration)
A. What is Data?

e Definition of data, its role in AL

e Structured, semi-structured, and unstructured data examples.

e Activity: Classify data examples under different categories.
B. Data Collection Methods

e Primary vs Secondary data.

e Techniques: surveys, interviews, experiments, web scraping, social media.

e Activity: Group students to simulate primary data collection via survey or observation.
C. Exploring Data

e Outliers, anomalies, pattern identification.

e Levels of measurement: Nominal, Ordinal, Interval, Ratio.

e Activity: Identify levels of measurement from classroom variables.
D. Statistical Analysis of Data

e Measures of Central Tendency: Mean, Median, Mode.

e Measures of Dispersion: Variance and Standard Deviation.

e Activity: Calculate central tendencies using Python.
E. Data Representation Techniques

¢ Non-graphical vs Graphical.

e Charts: Line graph, bar chart, histogram, scatter plot, pie chart.

e Activity: Plot different graphs using matplotlib and CSV data.
F. Matplotlib in Python

e Basic plotting: title, labels, legend, markers.

e Plot types and their use cases.

e Activity: Visualise study hours vs performance using scatter plot.
G. Introduction to Matrices

e Matrix definition, order, elements.

e Activity: Create student scores matrix and find its transpose.
H. Matrix Operations

e Addition, subtraction, scalar multiplication, transpose.

e Applications in Al: image processing, recommender systems, NLP.
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e Activity: Perform matrix operations and identify Al use case.
I. Data Preprocessing
e Cleaning, transformation, integration, reduction, feature selection.
e Handling missing, inconsistent, or duplicate data.
e Activity: Clean a dummy dataset in Python.
J. Training vs Testing Data
e Importance of splitting data.
e Train-test split, model generalisation.

e Activity: Split a dataset into 70:30 and explain the logic.

Extension

Ask the students some oral questions based on this chapter.

What are the three main types of data?

How does primary data differ from secondary data?

Can you explain what variance and standard deviation show us?
Why is it important to visualise data before drawing conclusions?

What is the difference between training data and testing data?

oo o000

How can matrices be useful in solving real-world Al problems?

Evaluation
e  Create infographic on primary vs secondary data.
e  Visualise your personal weekly screen time as a pie chart.

e  Explore Kaggle and download a dataset for mini analysis.

Summative Assessment
e  Short and long questions on central tendency, data collection, matrix applications.

e  Objective questions from textbook exercises.

Practical Assessment
e  Create and visualise a dataset using matplotlib.
e  Code and analyse student weights using mean, median, and mode.

e  Perform matrix operations in Python.

Suggested Activity

e  Python mini-project: Visualise temperature trends.
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Group project: Create survey-based dataset and analyse results.

Poster: "How Data Drives Al" or “Data Lifecycle Explained”.

Teaching Objectives

By the end of this unit, students will be able to:

+

+
+
+
+

1.

Understand the concept and real-life relevance of machine learning.
Distinguish between supervised, unsupervised, and reinforcement learning.
Apply regression and classification techniques in Python.

Understand the KNN algorithm and clustering basics.

Explore correlation and its interpretation using Python and Excel.

Number of Periods

Teaching Plan Theory  Practical

Introduction (Engagement)
Activities:
e Ask: "How do apps like Netflix, Google Maps, or YouTube predict your interests?”
e Brainstorm: "What is machine learning and how do we see it in daily life?”
e Show short video on ML basics.
Lesson Delivery (Explanation & Demonstration)
A. Introduction to Machine Learning
e Definition, importance, and features.
e Relation to AL
e Activity: Concept mapping — ML vs Al vs DL.
B. Types of Machine Learning
e Supervised, Unsupervised, Reinforcement Learning.
e Characteristics, examples, advantages, disadvantages.
e Activity: Categorise real-world problems into ML types.
C. Supervised Learning: Regression
e Linear Regression: equation, slope, intercept.
e Example: Predicting marks from study hours.

e Activity: Use Excel to calculate slope/intercept and plot best-fit line.
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. Supervised Learning: Classification

e Concepts and examples: spam filtering, document classification.

e Activity: Simulate vegetable classification via visual cues.

. KNN (K-Nearest Neighbour)

e Definition, working steps, applications.
e Program in Python to demonstrate classification using KNN.

e Activity: Use scikit-learn to implement KNN on Breast Cancer dataset.

. Unsupervised Learning: Clustering

e What is clustering and how it works.
e Types: Centroid-based, Density-based, Distribution-based.

e Activity: Group tourist spots (Amritsar example) — clustering simulation.

. Applications of Clustering

e Recommender systems, document classification, marketing, medical imaging.

e Activity: Group classification of mobile apps into similar use clusters.

. Correlation vs Causation

e Types: Positive, negative, no correlation, non-linear.
e Pearson’s r formula and interpretation.
e Activity: Calculate r using given age/income data in Excel.
Real-Life Applications of ML
e Healthcare diagnostics, fraud detection, weather forecasting, recommendation engines.

e Activity: Group case studies — identify the algorithm type used.

. Python Programming for ML

e Code: Implement linear regression and KNN in Python.
e Use libraries: NumPy, Pandas, Matplotlib, Scikit-learn.

e Activity: Predict scores, classify emails/images using simple datasets.

Extension

Ask the students some oral questions based on this chapter.

oo 0000
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What is the difference between supervised and unsupervised learning?
How is classification different from regression?

Can you give a real-life example of clustering?

What does the K in KNN stand for and how does it work?

What is correlation and how is it useful in data analysis?

Name a few Python libraries used for machine learning.
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Evaluation
e  Watch ML algorithm videos on regression/classification.
e  Build a project using Google’'s Teachable Machine.

e  Explore sklearn datasets and build classification models.

Summative Assessment
e  Objective questions from textbook.

e Long answer questions on ML types, regression logic, clustering uses.

Practical Assessment
e  Python exercises: Linear Regression, KNN.
e  Clustering simulation task using tourist grouping example.

e  Pearson’s r calculation in spreadsheet.

Suggested Activity
e Poster: “Supervised vs Unsupervised Learning” or “ML in Real Life".
e  Python Project: Predict salary based on experience.

e  Group Debate: "Can ML Replace Human Intelligence?”

Teaching Objectives
By the end of this unit, students will be able to:
+ Understand the importance of linguistics in human-machine interaction.

+ Comprehend core NLP concepts including tokenisation, entities, relationships, and coreference
resolution.

Identify classification problems in NLP due to ambiguity and context.
Differentiate between sentiment analysis and emotion detection.

Recognise types and components of chatbots, including intents and entities.

+ + + 4+

Explore the five phases of NLP: Lexical, Syntactic, Semantic, Discourse, and Pragmatic analysis.

Teaching Plan

Theory  Practical
1. Introduction (Engagement)

Activities:

e Ask: “"Can machines really understand human language?”
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e Show video clip on Al language tools (e.g. Siri or Google Assistant).
e Brainstorm: Challenges of teaching a computer to understand language.
Lesson Delivery (Explanation & Demonstration)
A. Linguistics and Machine Communication

e Human-machine interface importance.

e Limitations of machines in understanding context.

e Activity: List areas where machines misinterpret human language.
B. NLP Fundamentals

e NLP definition and tools (Siri, Cortana, Alexa).

e Georgetown-IBM experiment, NLP in structured vs unstructured data.

e Activity: Discuss examples of NLP-powered tools (spam filter, auto translate).

C. IBM Project Debater

¢ Purpose: Bias-free, evidence-based decision support.

e Four key steps: Understanding, Reasoning, Learning, Interacting.

e Activity: Role-play debate (student as Al using structured info).
D. Tokens, Entities, and Relationships

e Tokens: Word segments of text.

e Entity: Person, place, or thing.

e Relationship: Logical connection between entities.

e Activity: Extract tokens/entities from Groucho Marx's statement.
E. Coreference Resolution & Concept Extraction

e Definition and need.

e Concept: Implied idea in text.

e Activity: Resolve coreference in “Richa gave Aryan a book. He thanked her.”

F. Sentiment Analysis vs Emotion Detection
e Sentiment: Positive, neutral, negative.
¢ Emotion: Fear, anger, sadness, joy.
e Activity: Compare and classify feedback samples.
G. Classification Problems in NLP
e Ambiguity due to context (e.g., “cool person” vs “cool weather”).
e Activity: Interpret ambiguous sentences in different contexts.
H. Chatbots

e Chatbot definition, role, and industries.
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e Types: Rule-based vs Al-based.

e Activity: Match scenarios with appropriate chatbot type.
I. Components of Chatbots

e Intent, Entity, Dialog.

e Frontend vs Backend in chatbot structure.

e Activity: Create flowchart/dialog tree for hotel booking chatbot.
J. Five Phases of NLP

e Lexical: Tokenisation, stemming, lemmatisation.

e Syntactic: Grammar and structure.

¢ Semantic: Contextual meaning.

o Discourse: Bigger textual context.

e Pragmatic: Real-world interpretation.

e Activity: Classify sentences by NLP phase and analyse.

Extension

Ask the students some oral questions based on this chapter.

What is the difference between an entity and a token in NLP?

How do machines handle ambiguity in natural language?

What are the five phases of NLP and what does each one focus on?
How is emotion detection different from sentiment analysis?

Can you give examples of real-world chatbot applications?
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What challenges does NLP face while dealing with human language?

Evaluation
e Visit https://visuwords.com for concept mapping.
e  Try online chatbot platforms: botsify.com / Dialogflow.

e  Watch NLP tutorials and play Semantris word association game.

Summative Assessment
e  Objective and subjective questions from textbook.

e Long answers on sentiment vs emotion detection, IBM Debater phases, chatbot types.

Practical Assessment
e  Design and simulate a simple chatbot.
e Tag POS in sentences using NLTK.

e Analyse sentence for semantic meaning and discourse linkage.
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Suggested Activity

Poster: “5 Phases of NLP” or “Types of Chatbots".
Group project: Build a chatbot for school FAQs.
Scenario: Identify emotion or sentiment from customer reviews.

AI Lab Task: Run chatbot Python code and document interaction.

Teaching Objectives

By the end of this unit, students will be able to:

+
+
+

+

Define Al ethics and understand why it is important in today's world.
Explain the Five Pillars of Al Ethics: Fairness, Explainability, Robustness, Transparency, and Privacy.

Understand various types of biases in Al including data bias, algorithmic bias, and cognitive
bias.

Recognise the impact of bias in real-life sectors: healthcare, education, finance, and criminal
justice.

Explore strategies to mitigate bias in Al systems.
Understand the role of ethical dilemmas and moral reasoning in Al decisions.

Explore global efforts and policies to guide responsible Al development.

Teaching Plan

1.
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. Theory Practical
Introduction (Engagement)

Activities:
e Ask: “Can Al make decisions about your life without your knowledge?”
e Watch video: "Al is Monitoring You Right Now..."” and reflect.
e Discuss how Al interacts with personal choices and fairness.
Lesson Delivery (Explanation & Demonstration)
A. Al Ethics and Its Importance
e Define Al ethics — set of moral principles guiding AL
e Discuss why ethical Al is essential for fairness, trust, and inclusion.
e Activity: Case-based Q&A — Sakshi's bias in hiring.
B. The Five Pillars of Al Ethics
1. Fairness: No discrimination in outcomes.

2. Explainability: Al decisions must be understandable.
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3. Robustness: Al must function under varying conditions.
4. Transparency: Clear about data and decisions.
5. Privacy: Respect and secure personal information.
e Activity: Match real-world Al applications with the correct ethical pillar.
C. Types of Bias in Al
e Data Bias, Algorithmic Bias, Cognitive Bias.
¢ Real examples: Microsoft Tay, healthcare diagnostics.
e Activity: Bias identification exercise from text samples.
D. Real-Life Impact of Al Bias
e Sector-wise discussion: Healthcare, Education, Finance, Justice.
e Activity: Roleplay - students represent Al developers, policymakers, and citizens.
E. Mitigating Al Bias
e Strategies: Ethical guidelines, diverse data, audits, feedback loops, algorithmic fairness.
e Activity: Debate — "Can Al ever be truly unbiased?”
F. Developing Ethical Al Policies
e Policies and boards: IBM Al Ethics Board, Google, Microsoft, EU Guidelines.
e Components: Fairness, Safety, Inclusivity, Risk Assessment.
e Activity: Design a policy for ethical Al implementation in schools.
G. Ethical Dilemmas and Moral Reasoning
e Define ethical dilemma.
e Example: Pharmaceutical company’s drug with side effects.
e Activity: Discuss the case of autonomous cars — NEWAR car dilemma.
H. Moral Machine and Experiential Learning
e Visit MoralMachine.net and make ethical Al decisions.
e Game: Survival of the Best Fit — reflect on hiring decisions.

e Activity: Reflective writing on moral choices made in the games.

Extension

Ask the students some oral questions based on this chapter.

Q.

Q
Q
Q

What are the five pillars of Al ethics?
Why is explainability an important feature in ethical AI?
Can you give an example of data bias and how it impacts society?

What is the difference between algorithmic bias and cognitive bias?
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Q. How can ethical dilemmas be addressed when designing Al systems?

Q. Why is fairness critical in Al decision-making?

Evaluation

e  Research the Draft Al Bill 2023 (India).

e  Explore Al Fairness 360 by IBM.

e Analyse Al bias in generative tools like ChatGPT or Al art apps

Summative Assessment
e Short and long questions on bias, pillars, and ethical dilemmas.

e  Case study analysis (e.g., Sakshi and Aditi scenarios).

Practical Assessment
e  Moral Machine participation results and reflections.
e  Bias audit checklist for a mock Al system.

e Group project: Propose an Al ethical framework for school-based applications.

Suggested Activity
e  Poster creation: "Ethical Pillars of Al".
e  Group discussion: "Can we teach morality to machines?”

. Write an article: “The future of human values in a machine-driven world.”
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